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Welcome! 
 

Our Family Tree Builder software is now in Beta. 

 

This tutorial has been created specifically for our Beta testers in order to acquaint you with 

some of the useful and unique features found in Family Tree Builder. This tutorial assumes 

some basic familiarity with genealogy; it does not explain what genealogy is, and it does not 

elaborate on basic functionality that is found in any genealogy software. Instead, it focuses on 

features that make Family Tree Builder unique; features that you may never have encountered 

before in genealogy software, or aspects that require extra detail. 

 

Though this tutorial is lengthy, it contains many photos and screenshots that make it more 

interesting and easier to read. So we encourage you to spend a while reading through it and 

by doing so you will be able to make the most of this exciting new software, in the Beta and 

following it. 

 

We encourage you to send us your feedback and suggestions regarding the product and this 

tutorial. Many of the new features in the product were suggested by our Beta testers and we 

would love to include your suggestions in the product as well. Please send us your feedback via 

email to beta@myheritage.com, and we promise to cater to each and every request. 
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Key benefits of Family Tree Builder 
 

 It's free 

 

 No Spyware, Ad-ware or any type of Evil-ware  

 

 Simple to use with an intuitive user interface  

 

 Good looks 

 

 Powerful photo handling with face detection technology  

 

 Supports 12 languages, bi-lingual data entry and intelligent translations 

 

 Integrated with MyHeritage Family Pages: publish your family tree online in one click  

 

 Integrated with MyHeritage Research: research any ancestor in one click 

 

 Created by a team of experts in genealogy and professional software design,  

who applied their passion to this product  

  

 A breakthrough in genealogy software 
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A taste of Family Tree Builder… 
 

 
Above: screenshots showcasing our graphic design and multi-language support 
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Projects 
 
In Family Tree Builder, the main storage unit for your work is a Project. A Project is equivalent 

to a single GEDCOM file, plus all related photos, documents and files. It's up to you to decide 

whether to store your genealogy research in multiple projects (by splitting up your family tree 

into branches and storing each branch in its own project), or to keep it in one large project. 

 

Projects are saved by default below the Data subfolder of MyHeritage Family Tree Builder, but 

advanced users can modify this location in the configuration options. For example, if your 

project is called Smith, it will be saved by default in the following project folder:  

C:\Program Files\MyHeritage\Data\Smith 

 

If you are interested in understanding how things are stored at the file level, the following 

explanation is for you. Below each project folder, you will find the following subfolders: 

 

Database The project file is saved here. We invented a format called ZEDCOM which has 

a .ZED extension. It is really a zipped GEDCOM, much smaller in size than a 

GEDCOM and easier to send around. Our native format is a superset of 

GEDCOM in that it allows data fields to be saved in multiple languages 

 

Photos 

 

Photos associated with this project are copied here and stored here 

Cfg 

 

Project-related configuration is stored here 

Thumbs Not in use 

Backup Automatic backups are stored here. Just like in Microsoft Word, if you 

experience a crash while working on your family tree, the next time you start it 

you will be offered to recover the latest automatically saved backup. This will 

be very useful in case of a power breakdown, or a bug of ours 

 

Trash 

 

When you delete a file, such as a photo, the file will be moved here and will not 

be actually destroyed. This will allow you to change your mind even if you 

deleted some of your photos accidentally 

 

 

If you wish to back up a project, such as the Smith project in the above example, make a copy 

of this folder: 

C:\Program Files\MyHeritage\Data\Smith  

plus all of its subfolders. This info is also useful if you intend to transfer a project from one 

computer to another.  

 

The GEDCOM format, among its many deficiencies, calls for storing multimedia files with an 

absolute path. This prevents moving them around and makes it much more difficult to send a 

family tree with photos to another person. In our ZEDCOM format the paths are relative so 

your project will work wherever you place it, as long as the subfolder structure is preserved. 

 

Of course, Family Tree Builder supports the capability to export your projects to GEDCOM. But 

you will lose some of the functionality. For example, because GEDCOM files support only one 

language, if your project on Family Tree Builder is multilingual, you will need to select just one 

of its languages for inclusion in the exported GEDCOM file. 
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Running Family Tree Builder for the first time 
 

After installing Family Tree Builder, running it for the first time will present the Quick-Start 

Wizard. 

 

 
 

Figure: Quick-Start Wizard 

 

The goal of this wizard is to get you started quickly. Using it is optional. But it’s a quick way to 

create your own project, load our Sample project (the Kennedy family tree), or import a 

GEDCOM file in order to convert it into a new project. 

 

Tip! After you create your own project, the Quick-Start wizard will no longer come up at 

startup and instead, the last project you were working on, will be opened. The precise behavior 

of the program at startup is flexible and configurable. 
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Supporting multiple languages 
 

Multi-language support is an important feature of Family Tree Builder and affects almost every 

page of the application. Therefore before diving into the program’s functionality, this important 

topic should best be understood. You may skip this part if you intend to use English only for 

your family tree. But if you are interested in our unique capabilities of building a family tree in 

multiple languages, or viewing it in one language while entering data in another, read on. 

 

The current version of Family Tree Builder supports the following 12 languages:  

 
Additional languages will be added later on according to demand. 

This support of languages is based on a unique language infrastructure developed by 

MyHeritage from the ground up specifically for this product. 

 

Family Tree Builder supports these 12 languages in two independent aspects: 

1. Display language: the language of the user interface, including all menus, 

toolbars, dialog box fields, window headings, and other application text. You can 

select any one of 12 languages for the interface and change this setting at any time 

without losing your data or closing the program.  

2. Data language: this is the language in which you will enter your genealogy data. 

Family Tree Builder allows you to create a family tree in as many data languages as 

you need. You will only need to enter the facts for each language separately  (e.g. 

peoples' names and place names), while the relationships between the individuals 

and the various dates is entered just once and shared among the languages. Our 

translation wizard helps you translate names easily between languages. 

 

Tip! The Display language and Data language are independent in that you can combine them 

in almost any way you like. For example, you can view a French family tree that a relative had 

sent you, while keeping the user interface of the program in English. The only limitation is that 

if when using Hebrew or Yiddish (right-to-left languages), the Display language and the Data 

language must both be right-to-left, so you cannot view Hebrew data without changing the 

Display language to Hebrew as well. This is required in order to avoid text alignment issues.  

 

Tip! Family Tree Builder is one of the only programs in the world to support flipping from 

English to Hebrew, and this works even without restarting the program. This means that you 

can switch the Display language from English to Hebrew or vice versa whenever you want and 

can do this while the program is running. 

 

Tip! You can use any of the supported languages even without installing it on your PC, even 

more obscure languages like Greek. But in order to use Hebrew or Yiddish, your Windows 

needs to support a feature called 'mirroring' (available built-in on most recent versions of 

Windows except old Windows NT 4.0 and some old versions of Windows 98). 
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Tip! Multi-lingual family trees are great for family reunions! You can then create and print 

multi-lingual reports that showcase the same family tree in more than one language. 

 
 
The Virtual Keyboard 
 

Family Tree Builder provides a Virtual Keyboard that lets you enter data in any of the 12 

supported languages in case you don't have letters for that language on your computer's 

keyboard. Launch the virtual keyboard by clicking the keyboard-like graphic at the top of every 

page in Family Tree Builder, which looks like this: 

 
 

 

 
Figure 1: Russian Virtual Keyboard for entering Russian data  

 

The virtual keyboard will open up as a floating, topmost window. When you click a button on 

the virtual keyboard with the mouse, it will send that letter to the most recently used text box.  

The virtual keyboard adjusts itself automatically according to the current language settings. 

 

 

Project languages 
 

When you create a new project, you are asked to select two languages: a primary language 

and a secondary language. The primary language will determine your interface display 

language and your dominant data-entry language. The secondary language is your alternative 

data-entry language, and is optional. You may later change these settings at any time. 
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Examples of multi-language support 
 

Family Tree Builder comes with a sample project which is useful for study and practice: the 

Kennedy family tree. In our sample tree, there are two data languages: English and Hebrew.  

 

Figure 2 below shows the sample Kennedy family tree in a three-generation view. The Display 

language chosen is English, which means that the interface is in English (i.e. headers, toolbars, 

field names). Also, the data is in English (i.e. individual names, facts, dates, locations).  

 

 
 

Figure 2: Three-generation tree in English, showing data entered in English 
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In Figure 3 below, the same project is displayed in a three-generation view, but this time the 

display language has been switched to Hebrew. In this case both the interface and the data are 

shown in Hebrew.  

 

The dropdown menu marked in red, allows you to switch the Display language easily. You 

can choose any of the 12 supported languages for your interface in this dropdown.  

 

 
 

Figure 3: Three-generation tree in Hebrew, showing data entered in Hebrew 

 

 

Tip! Although the examples shown above are in English and Hebrew, you can in fact create a 

family tree in any subset of languages, e.g. Spanish and Portuguese. You are not forced to 

include English or Hebrew in your project, although supporting English is always a good idea. 
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Advanced language configuration 

 
In order to change the Data language, select Tools > Languages from the application's menu. 

The following page will be displayed: 

 

 
Figure 4: Tools > Languages page 

 

 

Here you can determine not only the Display language but also the primary and secondary 

Data languages. The primary Data language is the language of the family tree data which will 

be displayed in pages of the application where there is no data entry.  If there is no secondary 

data language, the application is in Single-language mode and all data entry pages will accept 

data in that language only. If there is a secondary Data language, the application is in Dual-

language mode and all data entry pages will be bi-lingual. 

 

Tip! By default, Family Tree Builder is configured so that the primary Data language is the 

same as the Display language. This means that by changing the Display language you will also 

instruct the program to change the Data language to match it. This keeps things simpler, but 

you may change this behavior. 

 

Tip! If you wish to enter genealogy data in more than 2 Data languages, you can use Dual-

language mode and toggle the secondary Data language from time to time between your 

secondary and tertiary Data languages. It's possible, but not convenient. 

 

Tip! If you don't intend to create multi-lingual family trees, configure the Languages page to 

have no secondary Data language and things will become very simple for you. 
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Getting Started 
 

You can start your new genealogy project on Family Tree Builder in two ways: 

 Create a new project, or: 

 Import a project from an existing GEDCOM file. Typically this will be a GEDCOM file that 

you have exported from other genealogy software. 

 

We will discuss both of these methods, and how to continue building your tree in Family Tree 

Builder. 

 

Creating a new project 
This is done by taking the following steps: 

1. Select “New Project” from the file menu, or click the “New” icon on the toolbar.  

You can also get here from the Quick-Start wizard. 

You will be taken through a brief wizard for creating a project. 

2. In this wizard, enter a name for your new project. Use English letters only. 

3. Select languages for your project. This step involves selecting your primary 

language and your secondary language. See “Supporting multiple languages” above.  

 

 
 

Figure 5: Language selection during creation of a new project 

 

That’s it! That’s all you need to do to create your genealogy project on Family Tree Builder. 
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Growing the family tree 
 

Family trees are created and edited on Family Tree Builder using an intuitive user interface 

that is surprisingly simple to use. The philosophy behind it was to keep things highly visual and 

effortless, allowing the user to create and branch out a family tree just as one would do using 

pen and paper. 

 

For as long as your project is empty, an inviting wizard shown below is displayed, prompting 

you to start filling up the family tree with information. All you need to do is click the “Add 

Family” link. 

 

 
 

Figure 6: An empty project 
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Clicking the “Add Family” link takes you to your first data entry page “Add First Family”, seen 

in Figure 7, below, with some data that has been filled in:  

 

 
 

Figure 7: Data entry page for adding your first family 

 

In this page, you can fill in the details of the main family of your project, the family around 

which the rest of the tree will be grown. We suggest beginning with you and your spouse, or 

your parents, as individuals for whom you know every relevant detail. 

 

Read more below about Dual-language data entry. 

 

To enter the complete information for your first family, you may click on the additional tabs 

and fill in additional information about this family, such as specifying some children in the 

Children tab. Click the “OK” button and the main family in your family tree will be added. 
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Dual-language data entry 
 
In this example, we have created a project where the primary language (for the interface and 

main data entry) is English, and the secondary language is Hebrew. Having two data languages 

implies that all data entry pages automatically become bi-lingual as in figure 7. If you do not 

specify a secondary language, data entry pages become simpler (unilingual) with more room to 

enter each field.  

 

In bi-lingual data entry, data can be entered in both languages for each data field.  

Below is an example: 

 

 
 

Figure 8: Data field sample 

 

 

In the above example: 

 “Last Name:” – this is the title of the field. As the primary language chosen was English, 

the title is in English 

 “Kennedy” – this is the Last Name itself, as entered in the primary language box, in this 

case in English 

 this is the data for Last Name, as entered in she secondary language box, in – ”קנדי“ 

this case, in Hebrew 

 

Tip! If you intend to work in English only, this does not concern you. 

 

 
Translations 

Pay special attention to the Translation Buttons:  which appear in bi-lingual data entry 

pages.  These buttons are located between the two data entry boxes for the same data field. If 

a translation button is enabled (i.e. filled in black, and not hollow gray), clicking it will perform 

immediate translation from one data language to another in the direction of the arrow. 

 

Tips 

 Family Tree Builder comes with a built-in dictionary for translating names between 

languages (first names, place names, etc). You will be pleased to learn that this 

dictionary is rich and well-researched, so it is likely to save you a lot of typing when you 

create multi-lingual family trees. 

 

 In the Beta, the first-name dictionary comes in English and Hebrew. This is not a 

collection of archaic names that nobody ever used, but of thousands of the most 

common names in real use, including modern names that have started appearing in 

recent years, and older names that were common in the days of our ancestors. The 

dictionary supports spelling variations in all languages, so if you typed in the name of 

your ancestor as Havazelet, Chavatselet or similar derivatives, it will still be recognized 

and translated correctly. After the Beta the dictionary will be extended to cover 

additional languages and additional fields. 

 

 Family Tree Builder remembers and learns everything you type in. It remembers which 

data fields have already been entered in both languages, thus allowing for instant 

translation. For example, if someone in your tree had the uncommon name of Zizzy and 
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you enter that first name in the two data languages, Family Tree Builder will then learn 

this and automatically offer to translate one form of Zizzy to the other language. 

 

 If you don't like some of the pre-built translations offered by Family Tree Builder, 

simply override the translations and save the data. Family Tree Builder will learn this, 

understand that you prefer your own version and will use your translation from now on 

instead of the default one. 

 

 Clicking one of the Master Translation Buttons at the top of the data entry box: 

 
 will apply all available translations on the page at once. A very handy time-saver. 

 

 Note that dates are entered only in one data language as they are automatically 

translated to the other and there is no need to enter them twice. Also, in some cases 

when you select a value from a list of common options (e.g. someone's religion), if the 

religion that was selected is recognized, it will automatically be translated for you to the 

other language, to save you more typing. 

 

 Family Tree Builder has a convenient translation wizard to simplify translation of 

commonly used terms in your family tree. See section ‘Translation Wizard’ for more 

details. 

 

 If you intend to work in English only, all this does not concern you. 
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Adding more individuals to the tree 
 
It’s extremely easy to add new individuals to your family tree. In Figure 9, below, you see the 

result of data entered in the First Family page.  

 

 
 

Figure 9: The first family in your family tree, shown in Family Tree View 

 

In Family Tree View, each person on the tree is represented by a card. The primary couple, 

husband and wife, have a larger card that displays additional information, with tabs that may 

be clicked to view additional information:  

 
Tabs that have information in them, are denoted using a small green indicator, e.g.  

Other individuals in this view have smaller cards showing less information. 

 

Adding more individuals is intuitive:  

 

 To add Joe Smith’s father, simply click the “Add Father” link in the card above Joe 

Smith. 

 To add Jane Doe’s mother, simply click the “Add Mother” link in the card above Jane 

Doe. 

 To add Joe and Jane’s children, click on the “Add Children” link. 

 To add another person not related to Joe or Jane, select “Add Unrelated Person” from 

the Person menu. 

 

This way the family tree can be put together intuitively, starting with someone you know and 

branching out until all known information is covered. 
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The Selector 
 

As your family tree fills up you will see all the individuals being listed on the panel on the left 

side.  

This panel is called the Selector. 

 

 
 

Figure 10: The Selector (and one of its tooltips) 

 

The Selector is displayed for quick reference, listing all people in your family tree. You may 

double click any person in the Selector in order to navigate to that person’s card in the Family 

Tree View, or right-click any person in the Selector for more options. You can also run quick 

searches in the Selector by typing in a first or last name, sort the names, and even minimize 

the entire Selector to the side so as to give more room to the Family Tree View itself. Placing 

the mouse over any name in the Selector provides a tooltip with a photo, for convenience, as 

shown in Figure 10 above.  

 

Tip! It is possible to run advanced queries from the Selector. More about this further below.  

 

Tip! The icon in each row indicates whether the person is a male or a female, living or 

deceased (deceased individuals are grayed out), and whether there are photos for that person. 

or not. 

 

Tip! The Selector’s Tree tab is not functional in the Beta. 
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Relationships 
 

For describing relationships, Family Tree Builder provides the concept of a Home Person. 

By default, the Home Person is the first person added to the family tree, but you can set 

another person as the Home Person by right-clicking any person in Navigation View and 

choosing Set as Home Person from the Person menu. 

It is recommended to set the Home Person to be you, in your family tree project. 

Once the Home Person is set, clicking the Home button on the toolbar conveniently navigates 

to the Home Person:  

 
 

In addition, tooltips throughout Family Tree Builder provide a concise textual description of the 

relationship between any person and the Home Person. 

For example, the following tooltip describes how the founder of MyHeritage is related to Sir 

Joshua Hassan, the Jewish prime minister of Gibraltar for 20 years. 

 
 

When describing the relationship between spouses that are also relatives (e.g. cousins who 

married), Family Tree Builder displays both the primary and secondary relationships. The 

addition of the secondary relationship, if deemed undesirable, can be turned off in the 

program's configuration options. 

 

In the Selector, right-clicking any person provides a menu to show the relationship between 

that person and the Home Person, or any other person that you may select. Upon selection, 

the relationship is explained step-by-step in the Relationship Calculator. At present, the 

calculator displays the relationship textually; in one of our upcoming versions it will do so also 

visually. 
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Figure: Relationship Calculator 

 

 

Another available feature pertaining to relationships is the ability to sort the entire family tree 

by 'proximity' to the Home Person. You can do this by extending the width of the Selector, and 

clicking 'Relation' which is the rightmost column. The closest relatives of the Home Person will 

be listed first, with those not related at all to the Home Person closing the list. 
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Importing an existing GEDCOM file 
 

It is possible to start working on your genealogy project with Family Tree Builder by importing 

your data. You can import a GEDCOM file exported by another genealogy application to start a 

new project, or merge its contents into the currently open project. 

 

Start by selecting “Import Gedcom” from the File menu. Then: 

1. Browse and choose the GEDCOM file you wish to import. 

2. Choose a Primary Language for your project. This should be the language that the 

GEDCOM was created in. 

3. Fill out the GEDCOM configuration page, shown in Figure 11 below 

 

 
 

Figure 11: GEDCOM Import Configuration options 

 

We have tested the GEDCOM Import feature on over 5,000 family trees downloaded from the 

Internet. This was necessary because many genealogy products do not adhere precisely to the 

GEDCOM format, or suffer from inconsistencies that exist within the format itself. We do our 

very best to recover your data as faithfully as possible and believe we have developed the 

most accurate GEDCOM import functionality anywhere. However, there are always new issues 

found with this capability, so if you notice errors or deficiencies that occurred in the import 

procedure, send us the details so that we may further improve the import process. 

 

Tip! We support importing of media files and documents referenced by a GEDCOM file, 

including photos. However, some genealogy products reference them using proprietary non-

GEDCOM tags. If your photos are not imported correctly, please send us your GEDCOM file for 

us to fix this. 
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Tip! Advanced users may view a report produced at the end of the import, showing which 

unexpected tags were found in your file and how they were handled. 

 

Tip! We support a GEDCOM import from Dorotree, even of bi-lingual family trees (e.g. English 

+ Hebrew). 

 

Tip! The ability to merge a GEDCOM file into current project is partially done. Currently the 

import will be done in full and there is still no functionality to compare, side by side, your 

existing family tree and the one in the imported GEDCOM, and ask you to pick which specific 

records you wish to import and which ones to reject. This functionality is planned for a future 

release. 
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Working with Family Tree Builder 
 

Family Tree View 
Family Tree View is where you build your family tree, and navigate within it. Below is an 

example with the Kennedy family: 

 

 
 

Figure 12: Three-generation view 

 

You can select to view three generations (default), five generations or seven generations at a 

time by clicking the corresponding button on the Generation picker in the top right corner (or 

top-left corner when working in Hebrew): 

 
 

Three-generation view is the most clutter-free mode, showing a primary couple (husband and 

wife), their parents and children.  

 

Tip! To navigate to any person and make that person primary, click on the person’s name. 

 

Tip! For each person, a ‘Personal Photo’ is displayed if one was specified. We found that it is 

much more intuitive to navigate inside a family tree when photos are displayed for each 

individual, especially if you are highly familiar with that family tree. This intuitive navigation is 

one of the most useful capabilities of Family Tree Builder. 

 

Tip! Family Tree View itself is used for navigation, not direct data entry. If you wish to edit 

data, click on the Edit buttons, or right-click any person or family and then choose Edit, or 

double-click any person or family. As a navigation-only page you are protected from making 

accidental changes to your data. 
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Tip! There is an extensive context menu available for each person, by right-clicking the 

person’s card. The same context menu can be opened by clicking the ‘Edit’ button on a person 

card (useful for users who are not familiar with right-clicking).  

This context menu typically looks like this: 

 
From the context menu you will find a rich selection of options which constitute all you will 

need to put together a family tree.  

The person context menu is also available by clicking a person and then using the ‘Person’ 

menu at the top of the page. 

 

Tip! Families also have a context menu, which is different from a person context menu. You 

can access it by right-clicking any gray family card or small icon card, or by clicking the ‘Edit’ 

button on a gray family card. 

 
The family context menu is also available by clicking a gray family card and then using the 

‘Family’ menu at the top of the page. 

 

Tip! Three-generation view is great if you prefer simplicity. But if you want to show more 

people at the expense of increasing clutter, choose five-generation or seven-generation views. 

 

Tip! You can configure the look & feel of Family Tree View to suite your preference. More about 

this further below, in section ‘Configuration Options’. 

 

Tip! A person card of the primary husband or wife always displays the siblings, half-siblings, 

step-siblings and additional spouses of that person. These names are all links that may be 

clicked for intuitive and immediate navigation to a sibling or spouse. See example below: 
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In a five-generation view, the grandparents and grandchildren of the primary husband and 

wife are shown as well: 

 

 
 

Figure 13: Five-generation view 

 

Also available: seven-generation view, which adds two more generations, and is recommended 

for owners of large display monitors. 
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Adding a person 
 

A simple way to add people to the tree is to click the empty Add Father, Add Mother, Add 

Spouse cards that appear for people who do not have a father, mother or spouse respectively.  

 

The primary family in the view also has a gray family card denoting the couple’s family. To add 

a child to the primary family, click the Add Child link in the family’s card. 

 

Whether you are adding a mother, a father, a spouse or a child to an existing person, or 

adding a person unrelated to all others, the ‘Add Person’ Wizard is shown: 

 

 
 

Figure 14: ‘Add Person’ wizard 

 

This Wizard allows you to quickly enter the basic information about the person you are adding. 

To supply more details about the person, click the ‘More Details’ button that opens the full Edit 

Person Details page (see below).  

 

Tip! The ‘Add Person’ wizard, like all other wizards in Family Tree Builder, only supports data 

entry in one language. If you are working with two data languages, you can add data in the 

secondary language by clicking ‘More Details’. 
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Editing person details 
 

Family Tree Builder allows you to enter many different data fields for each individual on your 

family tree. Also, each data field can be entered in your primary and secondary languages. 

 

The page in which person details are entered is one of the most important ones in Family Tree 

Builder and one that you will be using very often to enter data. 

 

You can reach the detailed individual data entry page in several ways: 

 Click the ‘More Details’ button in the ‘Add Person’ Wizard 

 Double-click the person’s card in the Family Tree View 

 Click an ‘Edit’ button on a person card 

 Right-click a person card and select ‘Edit Details’ 

 

 
 

Figure 15: Editing person details 
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The tabs in the ‘Edit person details’ page are rich in information and contain most genealogy 

fields you will need. Each of the tabs provides the means to enter additional facts about the 

person. These include: 

 

 Multiple names, as per GEDCOM spec. This is useful for recording conflicting 

information. There is also extensive support for entering religious names, nicknames, 

former names, etc., in a separate ‘Names’ page accessible from ‘Main’ tab 

 

 Extensive event information for birth, death, marriage, education, occupation and more 

 

 Personal attributes such as physical traits, medical history, religion and nationality 

 

 Contact information (including multiple addresses, if required) 

 

 Citations and notes allow you to track and source your research 

 

 Dates according to the Gregorian calendar, the Hebrew calendar and the French 

Revolution calendar, with automatic conversion between the three systems 

 

 

Tip! For females, you can enter a maiden name and a married name, separately. 

 

Tip! You will be pleased to find that Family Tree Builder supports the full GEDCOM spec 

including sources, notes and citations. These elements are supported recursively, so you can 

add a note to a person, associate that note with a citation that ties it to a source, add another 

note on that specific citation, and so on. You can also assign notes to specific events in the 

person’s life, or to one of his/her names, instead of assigning them to the person as a whole. 

 

Tip! Some Mormon-related properties like Sealings and Ordinations that are part of the 

GEDCOM spec are not supported yet. 
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Person facts 
 
The GEDCOM specification defines two similar elements for a person: Events, and Attributes.  

To keep things simpler we have united them, and refer to them as Facts. 

All facts about a person can be viewed and edited conveniently in the Facts Tab in the ‘Edit 

Person Details’ page. When you modify a fact in other tabs, such as birth date or occupation, 

your updates will be reflected automatically in this Facts tab even before you save the data. 

The Facts Tab is also a good place for adding facts that are less common, such as a Bar 

Mitzvah or Circumcision. 

 

 
 

Figure 16: The Facts tab 

 

Tip! You may click any fact and edit its information at the bottom of this page. You may also 

double-click it to obtain a more detailed ‘Edit Fact’ page. 

 

Tip! If you have conflicting information, such as two possible birth dates for the same person, 

use this page to add them. You may add each fact as many times as you need.  

 

Tip! To add a fact, click ‘New Fact’. The wizard that will open will provide a rich listing of 

predefined fact types but you may also create your own. This is not recommended because  

custom facts that you make up cannot be automatically translated into other languages. 
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Editing family details 
 

A family consists of a husband, a wife, optional children, and optional facts, such as marriage, 

divorce, engagement, etc. It is ok to have families where one of the spouses is missing or 

unknown. Family Tree Builder also supports same-sex unions. 

 

To enter information about a family, double click the family card in Family Tree View, or click 

its Edit button. The primary family has a large gray card that shows some details about the 

family while all other families in the view have a small icon that represents the family’s status. 

Both types of family cards can be double clicked for editing and present the page below: 

 

 
 

Figure 17: Editing family details 

 

Each of the tabs in the family’s data entry box provides the means to enter additional facts 

about the family. There is also a Facts tab similar to the one in the ‘Edit Person Details’ page. 
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Entering dates 
 

One of the problems with many genealogy products is that they do not encourage correct entry 

of dates, by giving the user a free text field and taking its contents as-is. We try to improve on 

this by providing a date editor component which provides a graphical user interface for 

entering a date, and exposes the full power of expression that the GEDCOM format provides 

for dates. 

 

To open the date editor, click its icon shown below in any field for date entry: 

 
 

 
 

Figure 18: The Date Editor 

 

The date editor lets you enter dates in many formats, or even in free text if you insist. It helps 

you by providing a visual calendar too, which shows you the day of the week for each date in 

case that is helpful. Use the editor’s drop-down menus to enter dates like: 

* Before June 1950 

* Between About 1950 and December 19 1952 

 

Dates entered using this editor are guaranteed to be stored correctly in the GEDCOM file, and 

once stored correctly, Family Tree Builder will also be able to translate them automatically for 

you into any language. 

 

An important feature of the date editor is its capability to convert a date from one calendar 

system to another. The following calendars are currently supported: Gregorian, Hebrew, and 

French Revolution. You can even convert partial dates like ‘February 2000’, which is a unique 

feature. In the near future we will also provide conversion of holidays, for example allowing 

you to convert ‘Christmas 1940’ into an accurate Hebrew date or range of dates. 
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Searching for people 
 

Family Tree Builder has powerful people search capabilities. To access them, click the 

magnifying glass icon in the Selector, shown below. 

 

 
 

The ‘Search for People’ page will open, as shown below. 

 

 
 

In this page you can search for people based on numerous conditions: 

 

 Any element of their name (contains, equals, starts with, ends with, is empty, is not 

empty, sounds like [DM Soundex], etc) 

 Any fact  (exists or not, matches a specific type, place, date or description) 

 Having a specified number of spouses, children, parents or siblings 

 Having photos, etc. 

 

You may run a search and see its results in the Selector, and even save your searches for 

future reuse. Manipulating saved searches can be done by clicking ‘Manage Saved Searches’ in 

this page. If you saved a search, you may summon its results in the Selector by selecting its 

name from the Selector’s pull-down menu. 



Family Tree Builder: Tutorial (Beta)   

[33]  Copyright © 2006 MyHeritage Ltd. All rights reserved. 

Photographs 
 

Powerful photo handling is one of the fortes of Family Tree Builder.  

Photos are invaluable for genealogy research and help bring a family tree to life. By scanning 

old photos, adding them to your project on Family Tree Builder and properly annotating them, 

you will treasure your family’s history and allow your family, relatives and friends to enjoy 

these photos in more ways than you may have thought possible. This will also likely to benefit 

your research, because old photos can often jog the memory of your old relatives and lead to 

information found nowhere else. Photos added to your family tree may also be published online 

into your own family Website on MyHeritage (this functionality is coming soon). 

 

In order to revolutionize photo support for family trees, we strayed from the poor GEDCOM 

specification for photos, and designed this from scratch, instead of being shackled by the 

deficiencies of the GEDCOM format like many other products. In Family Tree Builder, photos 

are not an afterthought: they are one of the most important aspects of the program and, 

historically, this was why we embarked on developing Family Tree Builder in the first place. 

 

In redesigning the use of photos in genealogy, we set forth, and successfully fulfilled, the 

following goals: 

 Allow the user to add a photo just once and then associate it with all applicable 

elements in the family tree: people, families, person facts, family facts, and more. 

 

 Allow the user to not just associate a photo with a person, but also mark where in the 

photo that person’s face appears. This is particularly useful for group photos where 

multiple people appear: you want the system to know where exactly each person is, 

instead of letting the user describe this poorly using text, e.g.  

”Grandma is 14th on the right on the 6th row from the bottom”. 

 

 Allow the user to designate any marked face as a ‘personal photo’ of a person. That 

‘personal photo’ will become a face thumbnail that will appear in the Family Tree View 

and in various reports. Do this without forcing the user to create a separate image for 

the thumbnail. This is superior to other genealogy products that can only be told that 

one of the person’s photos is ‘primary’ and show it in reduced size: since the photo 

often includes more than a face, such as a full body, when reduced it becomes an 

unreadable miniature, but this is not the case in Family Tree Builder. 

 

 Old photos often have important inscriptions and dedications on their reverse side. 

Genealogists would want to scan them and associate them with the front side of each 

photo, instead of treating them as separate photos. We are the world’s first company to 

have realized this and have added specialized support for the reverse side of old 

photos. 

 

 Let the user run powerful photo queries, e.g.  

Show me all photos where I am with my grandfather Chaim 

or 

Show me all photos taken in Bialystok (or a place that sounds like this using DM 

Soundex) in the 1930’s 

or 

Show me all photos showing my great-uncle Menachem or any of his descendents 

 

 Make it easy and intuitive for the user to mark faces on a photo and teach the system 

to whom each face belongs. 
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 Use advanced Face Detection technology to find faces automatically. 

 

 Display photos with faces innovatively so that the user, who could be a child you are 

introducing to the family tree, may move the mouse over any face to learn who that 

person is, or move the mouse over any name to learn where that person is in the 

photo. This makes the browsing in photos an engaging and fun experience that is likely 

to draw a young audience closer to genealogy, and to the family itself. 

 

 

To recap, Family Tree Builder has extensive and unique support for photographs. You can 

easily integrate photos of your ancestors into the family tree. Family Tree Builder helps you 

organize all the historical photos and scanned documents that you have gathered, and link 

them to the correct persons on your tree. Unique face detection technology makes the task of 

annotation quick and simple to use.  

 

If you have old photos lying around in dusty albums, shoeboxes or attics, Family Tree 

Builder gives you the perfect reason to pull them out after all these years, scan them, 

organize them and make them delightfully presentable for others to enjoy. 

 

Tip! Family Tree Builder features Face Detection technology: automatically finding faces in 

photos.  Face Recognition technology, which is more advanced (automatically identifying who a 

person is) is available on MyHeritage Family Pages, after you publish your family tree and 

photos to your own family site on it (coming soon).  
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Photo View 

To manage photos, click the Photos button on the main toolbar:  

You can also click the ‘Photos’ button on any person in Family Tree View to view the photos 

where he/she appears. Photo View will then be displayed.  

 

 
 

Figure 19: Photo View, viewing “All Photos” in Table mode 

 

Tip! When in Photo View, if you wish to return to Family Tree View, click the Tree icon in the 

main toolbar:  

 
 

Tip! In Photo View, there is a Selector on the left. Double-clicking any person on it will show 

you all photos of that person on the right.  

 

Tip! A cool feature is the photo size slider:  

You can use the slider to change in real-time the size of the thumbnails displayed. 

This lets you control the tradeoff between photo size and quantity: you may select to see more 

photos at a time, but each thumbnail will then be smaller. 

 

Tip! You can switch to view the photos in Thumbnails mode, which, compared to Table mode, 

shows more photos but with less textual information about them. 
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Figure 20: Photo View, viewing “All Photos” in Thumbnails mode 

 

 

Tip! In Photo View, you may associate a person with a photo (indicating that he or she 

appears in it) by dragging the name of the person from the Selector on the left, onto the 

photo. This can also be done, in more detail, in the Edit Photo page described further below. 

 

Tip! You can right-click any photo and then Edit it, View it (full size) or Delete it.  

Double-click any photo to edit it. If there are people that you’ve associated with this photo, the 

right-click menu will allow you to quickly navigate to them in the family tree, as shown below: 
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Adding a photo 

To add a photograph click the “New Photo” button on the main toolbar:  or choose “New 

Photos” from the Photos menu. The “Add New Photos” wizard will be displayed, asking you to 

browse for the photos you wish to add to your tree.  

 

 
Figure 21: Add New Photos wizard 

 

Click 'Browse' and select one or more photos that you wish to add. 

After selecting your photos, their filenames will be listed. Click Next to add them. 

Photo View will then display all the photos you've just added, under a special view called 

'Recently Added Photos'. You will be able to edit each one and enter additional information for 

it, such as its title, place, date, etc. 

 

It is also possible to use this wizard to add documents to the family tree, not just photos. 

Documents may include video files, audio files, Word documents, text files, zip files, 

spreadsheets, etc. Documents can be edited and associated with family tree people, families, 

facts, etc, just like photos. In Photo View, they are displayed as icons according to their type. 

 

Tip! Documents are displayed along with photos, in Photo View. Family Tree Builder still refers 

to them in the various pages as photos, but documents do not provide photo-specific features 

like face recognition, obviously. On the other hand, it is possible to open documents for 

viewing in an external program, by right-clicking them. We plan to provide separate and 

improved handling of documents in upcoming versions.  
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Editing a photo 
 

The most important aspect of adding a photo to your family tree is annotate it with information 

and associate it with individuals, families or facts in your tree. To edit a photo, double-click it 

in Photo View, or right-click it and choose “Edit.” 

 

The first tab in the Edit Photo page is the Info tag. A default name for the photo is entered 

automatically based on the filename but you are encouraged to modify it and provide a 

meaningful title. Specify the date, place and other notes; the more information you provide, 

the richer your family tree will become and the easier it will be for you to locate photos you 

need in photo queries.  

 

Linking family tree individuals to faces 

 

At this stage, Family Tree Builder auto-magically detects faces in your photograph and 

highlights them with a dashed green rectangle: 

 

 
 

Figure 22: Automatic Face Detection: the detected faces are marked in dashed green  
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To teach the program to whom each face belongs, simply drag a name from the Selector on 

the left onto any of the marked faces.  

 

Tip! If you know that a certain person appears in the photo, but do not know where (e.g., you 

know that a certain relative of yours appears in a particular kindergarten photo in Minsk, but 

you cannot recognize her among the other children), just double-click the name in the Selector 

without dragging it onto a particular green rectangle; this will indicate that the person is in the 

photo but without specifying the precise position. 

 

Tip! Family Tree Builder is quite good at detecting faces automatically. But for this to be 

possible, the faces need to be frontal and large. Faces that are very small, or appear in a sharp 

angle or in profile, will not be detected automatically. But you can mark all missed faces 

manually (we’ll explain how below).  

 

Tip! Occasionally the program will incorrectly detect some object in the background as a face. 

This is called a “false positive”; simply ignore these false positives.  
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People and Families tab 

 

In this tab you can manage associations of faces to family tree individuals. You will 

automatically be taken to this tab if you drag a person from the Selector onto the photo or one 

of the automatically detected faces. You may also visit this tab on your own. 

 

 
Figure 23: Associating faces with names 

 

 

In the ‘People and families’ tab, you may: 

 View a list of people and families who’ve been associated with the photo so far 

 

 Delete any unwanted entries from this list 

 

 Add more to the list by dragging and dropping a name from the Selector onto a face on 

the photo, or onto the list itself 

 

 Select any name from the list and set the position of that person on the photo 

manually. This is the only way to mark faces missed by automatic face detection 
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Once an individual has been associated with a face, its frame will change from dashed green to 

red. You may then use drag & drop or resize to fine-tune the precise position and size of the 

rectangle, because sometimes automatic face detection captures a face well but does not 

frame it with absolute precision (manual adjustment like this is recommended only for severe 

perfectionists!). 

 

Setting a Personal Photo 

 

By selecting a person whose face has been marked (shown in red) and clicking ‘Personal Photo’ 

the program will automatically generate a Personal Photo that will be used for that person in 

the Family Tree View, and in various reports and tooltips. The proportions of a Personal Photo 

must be 3:4 so you can move and resize it, but these proportions will always be maintained. 

 

 

 
 

Figure 24: A Personal Photo (shown in Family Tree View) 

 

 

Tip! It is strongly recommended to set Personal Photos for all people in your family tree, for 

whom you have photos. 

 

Tip! To fine-tune a Personal Photo, such as tweak its position, you may right-click a person in 

Family Tree View and select ‘Photos’ > ‘Edit Personal Photo’. 

 

 

Associating a photo with a family 

 

You can also associate a photo with a particular family in your tree. For example, you can add 

a picture from the wedding, or a group photo showing the husband, wife and all their children, 

and associate it with that family. 

 

To add a family, click the small arrow near the “Add” button in the Edit Photo, “People and 

Families” tab, as shown below. Then select ‘Family’ from the drop-down menu. 
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All families in your tree will be listed, in a page called Family Selector.  

Double-click one of the families, or click it and click ‘Select’, to associate it with the photo.  

 

 
Figure 25: Family Selector 

 

 

Tip! When associating a photo with a family, it is recommended to also associate it with the 

individual people who appear in it.  

 

Tip! When associating a photo with a family, there is no way to ‘mark’ the family on the photo; 

marking is only for individual people and not for families. 
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Associating a photo with a fact 

 

This is done in the Edit Photo, Facts tab. You may associate the photo with any event in the life 

of a person or family in your family tree. For example, a graduation photo should best be 

associated with a graduation fact for a person; A wedding photo should best be associated with 

the marriage fact for a family; a tombstone photo should best be associated with the burial 

fact for a person, and so on. When you perform such association you will be given the option 

to copy over the date and place information from the fact (if available), to the photo. 

 

 

Similar photos, and reverse sides of photos 

 

If you have scanned old photos you have probably made, in some cases, multiple scans of the 

same photo. Perhaps you scanned different copies of the same photo, each one with its own 

“problems”, scratches or holes; or scanned the same photo in different resolutions. In order to 

avoid adding the same photo several times to your family tree, in case of very minor 

variations, you can add one “master” version of each photo and add the other variations as 

“similar photos” for it. The similar photos will be stored in your family tree, but will not be 

displayed in Photo View. Adding similar photos is done in the “Similar photos” tab in Edit Photo 

page. If the photo has an interesting inscription or dedication on its reverse side, you are 

encouraged to scan it, add the result as a similar photo and then click the ‘Set Reverse’ button, 

to tell Family Tree Builder that this photo is in fact the reverse side of the master photo. When 

photos are published to the Web on MyHeritage Family Pages, the reverse side of each photo, 

if available, will be displayed attractively below the front side. 
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More about associating photos with facts  

 

Above, we have explained how to edit a specific photo and associate it with various elements 

in the family tree. However, Family Tree Builder also supports associating multiple photos at 

once with a specific element in the tree. For example, if there are 10 photos that were taken in 

a specific wedding, it is too cumbersome to edit each one and associate it with the wedding 

event. Instead, you can open the ‘Edit Family’ page, go to the Facts tab, click the ‘Wedding’ 

event and then click ‘Fact Photos’. You will get a convenient page for associating multiple 

photos with a single element in the family tree, which can be a person, a family, or a fact.  

 

 
 

Figure 26: Associating multiple photos with a Marriage event 

 

 

Simply select one or more photos on the right and click ‘Add’ to associate them with the 

element. Then click OK to save. 
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Adding multiple photos 
 

In order to add a large number of photos to the family tree at once, choose “Import Photos” 

from the Photos menu. A wizard for this purpose will be displayed. Select a folder that you 

would like to upload at once, indicating whether or not its subfolders should be included too, 

and click Next. All photos found in the folder you specified will be added. You can then go over 

them and annotate them one by one. 

 

 

 
 

Figure 27: Import Photos wizard 
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Searching for photos 
 

Family Tree Builder has powerful photo search capabilities. To access them, click the ‘Query’ 

tab from Photo View. 

 

 
 

Figure 28: Photo Query 

 

In the photo query tab you may conduct elaborate searches for photos, such as: 

 

 All photos in which specific people appear (choose them using the ‘Select’ button, or, 

more simply, drag their names from the Selector on the left right into the query list) 

 

 All photos matching specific conditions on their title, date and/or place 

 

 All photos associated with a specific family, or person/family fact 

 

Tip! DM Soundex is supported for place names, so you can search for all photos taken in any 

place that sounds like the town name you are looking for. 

 

Tip! You may save a query for quick reuse. Click ‘Manage Saved Queries’ button to review 

queries you have saved in the past. 

 

Tip! To quickly obtain all photos in which a particular person appears, you don’t need to use 

the Query tab. You can just double-click that person in the Selector in Photo View. 
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The results of any query you run will be displayed in the Photos tab of Photo View, as shown 

below: 

 

 
Figure 29: Results of a Photo Query 

 

 

Tip! Take note of the query name in the pull-down menu marked above. You may select 

another entry from this pull-down to revert to view all photos, or to quickly run one of the 

photo queries you have previously saved. 
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Viewing photos 
 

Family Tree Builder comes with a potent, standalone photo viewer. To access it, right-click any 

photo in Photo View and select ‘View Photo’, or click the photo and then click the View Photo 

icon in the toolbar: 

 
 

The photo viewer will display all photos currently displayed in Photo View (which can be all 

photos in your family tree, or just those matching the last query you ran). 

 

The photo viewer provides convenient resizing capabilities. But its most exciting feature is the 

unique way it uses the face-to-person correlation data that you provided while adding and 

editing your photos. The photo viewer can use that data to answer two important and 

interesting questions: 

 

 Matching a name to a face (see figure 30 below):  

Given a face in a photo, whose face is this?  

 

 Matching a face to a name (see figure 31 below): 

Given that a person is known to appear in a photo, where is he/she? 

 

 
 

Figure 30: Move the mouse over any face to see who that person is (tooltip) 
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Figure 31: Move the mouse over any name to see where that person is (red frame) 
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Configuration options 
 

To configure Family Tree Builder, click “Options” under the “Tools” menu. 

 

The Options page allows you to configure general, display and date options. 

 

 
 

Figure 32: Configuring Display options 

 

Below are some of the flexible Display aspects which you can configure here: 

 

 Format of names throughout the program. 

Do you prefer ‘Abraham Cohen’, or ‘Abraham COHEN’, or maybe ‘Cohen, Abraham’? 

By a simple change here, all names in the application will be transformed, though 

internally they will remain stored how they were entered. This is much better than 

modifying all names by hand to suit your preference. 

 

 Display of ages in Family Tree View: on or off 

 

 Wire-frame effect during navigation: on or off 

 

 How to indicate people with no photos 
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 Visual theme of Family Tree View. 

You may customize the important Family Tree View in which much of the work on the 

family tree is done. Change the style, modify the colors entirely if you wish, etc.  

See below for some of the built-in styles available for selection. 

 

 
 

 
 

 
 

 
Figure 33: Visual themes of Family Tree View  

From top to bottom: Gradient (default), Outline, Vertical, Horizontal 
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Date configuration 

 

In the options page, clicking ‘Dates’ allows you to control how dates are displayed throughout 

the Family Tree Builder, e.g. whether to use “May 20 2006” or “20 May 2006”.  

 

You can also determine whether, when the program is using Hebrew, it will display Gregorian 

dates, Hebrew dates or both. Similar configuration is available separately for each language.  

 

So if working with Hebrew dates is very important to you, or on the contrary, you prefer to 

work without them, you can configure the display to match your preference.  

 

You can even request the display of Hebrew dates in English, which would result in something 

like this: 

 
Whereas the same in Hebrew would look like this: 

 

 

General configuration 

 

In the options page, clicking ‘Main’ allows you to tweak general settings. 

Here you can control: 

 

 How often the program should save automatic recovery information (default is every 5 

minutes). This protects you against data loss in case of crashes and other disasters. 

When you run Family Tree Builder, if the program did not exit properly last time you will 

be offered to recover the last automatically saved backup. 

 

 Where the Projects are stored on your disk. 

Modifying this is NOT recommended. 

 

 What the program should do upon startup, e.g., should it automatically open the last 

project you were working on, or perhaps come up empty.  

 

 Whether the program should check for updates whenever it starts running. 

Turning this on is recommended. 
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Translation Wizard 
 

Family Tree Builder provides a unique feature called the Translation Wizard, available from the 

Tools menu. This wizard is useful if you have a family tree in one language and wish to 

translate it quickly to another language. 

 

  
Figure 34: Source and target language selection in the Translation Wizard 

 
 

Translating a family tree into another language is useful, for example, if you have created your 

family tree in English in the past, and now Family Tree Builder gives you the opportunity to 

add your native language (which is not English) and produce family tree printouts in both 

English and your preferred language. 

 

The Translation Wizard automates the task of translating names, saving you the need to go 

over all the people and photos in the tree and manually translate their names and facts. The 

Translation Wizard is capable of translating first names, last names and place names 

automatically, using its extensive built-in dictionary. In the Beta version, the build-in dictionary 

supports English and Hebrew only, but the wizard is still useful for other languages. 

 

The wizard works by alternating between an automatic translation phase, and a manual 

translation phase, until you decide that you have translated sufficiently, and close it. 
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In the automatic phase, the wizard translates the names found in its built-in dictionary. A 

report is provided, showing you what it did. The wizard then proceeds to the manual phase 

where it shows you the ten most common first names, last names and place names in your 

family tree, that it could not translate automatically – and lets you translate them yourself, 

just once. It then re-runs the automatic phase and translates those names for you throughout 

the entire family tree. You can continue translating names manually until you feel that there is 

not enough gain in each translation (to help you figure this out, the wizard tells you how many 

times each unique name appears, letting you gauge how important it is to translate it). 

 

 

 
Figure 35: Manual phase in the Translation Wizard 

 

In the Beta version we are providing extensive translation for first names, and initial 

translation for place names, covering country names and places in Israel. In the next version 

we will provide a more extensive dictionary of place names, covering thousands of important 

cities worldwide. These dictionaries will later be translated into all our supported languages 

(not just English and Hebrew) and additional translations will be provided, for example for 

occupations. 

 

Recommended: after running automatic translation, a report can be viewed in an HTML file. 

This report includes names that were missing in our dictionary but common in your family tree. 

Email us this report file to beta@myheritage.com. It will help us add more names to our built-

in dictionary for your benefit and the benefit of other users. 
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Miscellaneous 
 

 

 All pages on Family Tree Builder are resizable.  

 

 
To change their size to dimensions that you find suitable, drag the resizing bar marked 

above. The dimensions will be saved automatically and restored whenever you open the 

same page again. 

 

 In Family Tree View you can specify some individuals as your favorites. Do this from the 

‘Favorites’ menu. After specifying such favorites you can easily navigate to them from 

the ‘Favorites’ menu. So this is a good method to arrange for quick access to some 

individuals in the family tree that you visit often. 

 

 In Family Tree View you may use the Back and Forward buttons on the toolbar to 

retrace your steps just like in a browser. You can even specify one individual as the 

“home” individual (this is done in ‘Favorites’ menu) and navigate to that individual by 

clicking the Home button on the toolbar. 

 

 You can manage Sources and Repositories, as per the GEDCOM spec, by selecting 

‘Sources’ or ‘Repositories’ from the View menu. 

 

 When setting up your family tree, you may easily enter several spouses for the same 

person. To do this, right-click the person in Family Tree View and select ‘Manage 

Spouses’ from the Spouses menu. The ‘Manage Spouses’ pages allows you to specify as 

many spouses as required for the current person, the top one listed will be displayed by 

default in the family tree. To add another spouse, either click ‘Add Spouse’, or ‘Attach 

Spouse’. The difference is that ‘Add’ lets you add a new person to the family tree and 

set that person as a spouse, whereas ‘Attach’ lets you select an existing person from 

the family tree and simply associate that person as a spouse of current person. The 

opposite of an Attach operation, called Detach Spouse, is also available. 

 

 To manage children of a family, right-click the family in Family Tree View and select 

‘Manage Children’ from the Children menu. Here you can add children, or attach them. 

See description above for spouses to understand the difference between Add and Attach 

operations. Note that you may associate children with a family under a Natural, 

Adopted or Foster relationship. The same child may be associated with several sets of 

parents, but the relationship of the connection should be set to indicate the difference 

between natural parents and adopting parents, for example. 

It is possible to manage a person’s parents by right-clicking a person and selecting 

‘Manage Parents’ from the Parents menu. The ‘Manage Parents’ page will be displayed. 

However, functionally to add or attach parents is currently available only from the 

Parents menu. 

 

 Family Tree Builder has an automatic self-upgrade capability. It can check whether an 

upgrade for itself exists on the Internet, and download and apply it if you permit it to. 

Family Tree Builder does not check for upgrades on the Internet of its own accord: it 

does so only when you run it, or manually request it by selecting ‘Check for Updates’ in 
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the Tools menu. If an upgrade is available you will be informed of its size and benefits 

and will be able to apply it in two clicks. 

 

Tip! If an upgrade is available, applying it is strongly recommended, as it is likely to fix 

problems encountered in the software by other users, as well as add additional 

features. 

 

 

 

***** 
 


